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ANALYSIS OF SOLID MATERIAL IN POROUS MEDIA 

WITH MATDICT  

For three-dimensional models of porous media obtained from a tomography image or 

from a digital model generated with GeoDict, the MatDict module analyzes the 
characteristics of materials. There is no fixed assignment of a material ID 

(identification) to solid or pore space. Instead, it depends on the definitions made for 
the constituent materials.  

 

MatDict’s commands are grouped by four topics: Material Statistics, Material 
Characterization, GAD Objects Analysis and Algorithms. 

MATERIAL STATISTICS 

◼ Structure Information: The algorithms determine porosity, solid volume 
fraction, number of GAD objects, density, mass and grammage in all three spatial 

directions. Values represent average values for the entire material(s) inside the 
bounding box. Additionally, the individual solid volume fraction of all materials is 

given as well.  

◼ Thickness Estimation (1D Statistics): The methods determine the solid volume 

fraction (SVF) of the material in the different spatial directions and measures the 
material thickness. The SVF is computed in the plane normal to the direction of 

interest and the average value for each of those planes is reported.  

◼ 2D Density Map: The algorithms calculate the distribution of grammage, solid 

volume fraction, and number of objects in the direction of interest. Each pixel in 
the density map is calculated by averaging the respective property in the direction 

of interest.  

◼ 3D Inhomogeneity: The algorithms compute the solid volume fraction, solid 

density (distribution) and porosity of specified sub-volumes.  

MATERIAL CHARACTERIZATION 

◼ The Solid Size Distribution (Granulometry) is determined by fitting spheres 
into the solid objects. To be more precise, a point belongs to a solid object of a 
diameter larger or equal than d, if it is inside any sphere of diameter d, which can 

be fitted into the solid objects. 
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◼ For the Percolation Paths calculation, the method determines the maximal 

diameters of spherical particles that can move through the medium. In addition, 
the shortest paths of the largest particles are calculated and displayed. Also, the 

shortest path of a given sphere size through the medium may be computed. 

◼ Connected Components: The solid fraction of a porous medium is not 

necessarily a homogeneous medium but can be composed of individual 
components that (all together) form the solid. Neighborhood relations between 
voxels inside a component differ from those among different components and 

between component and pore. The method analyzes the voxel-to-voxel relations 
of the solid material and computes the components that build up the solid fraction. 

Results of the method include the number of defined components (material and 
background), mean number of components per 2D slice in each spatial direction, 

and their size with respect to volume visualized as a histogram. 

◼ Estimate Surface Area: The algorithm calculates an approximation of the surface 

area by statistical methods and not simply by adding up the voxel surfaces. 
Therefore, the surface of a sphere is approximated correctly. However, the 
estimation is slightly biased in case of highly anisotropic media. The method 

originates from statistical image analysis, where the determination of the four 
Minkowski measures (Volume, Surface Area, Integral of mean curvature, Integral 

of total curvature) from voxelized images is an essential task. To determine the 
surface area, the Crofton formula is used, which relates at first the 3D surface area 
to an integral over 2D boundary lengths of planar cross sections and then second 

these lengths to an integral over 1D rays. Based on this formula, an analysis of 
the intersection points of rays in all space directions with the structure allows 

determining the surface area. 

◼ Estimate Three-Phase Contact Line: The algorithm estimates the length of the 

contact line between the phases in a three-phase system and the number of voxel 
edges of the contact line in the Cartesian directions. The length of the contact line, 

which strongly depends on the structure’s topology, is often important for the 

performance of a material (for example for catalysts). 

◼ The four Minkowski Parameters (Volume, Surface Area, Integral of mean 
curvature, Integral of total curvature) are the structures characterizing parameters 

to analyze mathematical topology and can be computed for a selected Material ID. 
These parameters can be used e.g. for image processing, estimating root lengths 

or hysteresis. 

◼ A Chord Length Distribution (CLD) is the distribution of the length of a typical 

chord of a structure. By being characteristic for any given geometry class, it is a 
highly precise and sensitive measure to compare the geometries of porous media. 
The calculation of CLD is particularly useful in 2D tomographic cross-sections, for 

which the pore size distribution cannot be determined by granulometry or by 
porosimetry. See the PoroDict handbook for further information about 

granulometry or porosimetry. 

◼ The Geodesic Tortuosity command computes the tortuosity of paths crossing 

the material, either through pore space or through solid materials. For every voxel 
on the outflow plane, the algorithm finds the shortest path through the selected 

material. 

◼ The 2-Point Correlation computes the probability for two voxels having a certain 

distance to be similar or equal. For each distance, several voxels are compared if 
they belong to the same type and a probability is computed based on this 
information. If two voxels are correlated, the probability is 1, if they are not 

correlated, for example in a completely random structure, the probability is 0. 

Then an average probability for each distance is given as result. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PoroDict&release=2024


Introduction 

GeoDict 2024 User Guide  3 

GAD OBJECTS ANALYSIS 

◼ Analyze Objects. The algorithms analyze GeoDict Analytic Data (GAD) for the 

total number of GAD objects, number of overlap objects (i.e. the overlaps between 
different objects), number of objects, overlap solid volume percentage, total 

number of contacts, mean coordination number, and the individual volume of each 
component. It provides histograms for object volume and contact area.  

◼ The GAD Objects Orientation analysis provides the direction tensor and 

anisotropy for individual classes of GAD objects. 

ALGORITHMS 

◼ In the Euclidean Distance Transform (EDT), the algorithm calculates the 

distance from any point (voxel) inside a pore to the nearest pore/solid boundary. 
This is useful when characterizing the structure’s pore morphology.  

◼ The Skeletonizer reduces any given structure to its center lines.  
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MATERIAL STATISTICS 

STRUCTURE INFORMATION 

The Structure Information command determines porosity, solid volume fraction 
(SVF), density, mass, and grammage in all three spatial directions for the volume 

inside the bounding box. For these calculations, the algorithm requires the density of 
all solid materials as input data.  

 

After selecting Structure Information from the pull-down menu and clicking the 

Options’ Edit… button, the Structure Information dialog opens. 

 

At the top of the dialog, replace the default Result File Name by a name according 
to your current project. The result files are saved in the chosen project folder (File → 

Choose Project Folder in the menu bar).  

Underneath, the Material panel contains the material IDs of the constituent materials 
present in the current structure, and the Solid Density tab contains the density 

information for each of the present material IDs. 
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By default, material IDs that are not present in the structure are not displayed under 

the Material tab, but they can be displayed by clicking on the “+” symbol to the left 
of the Material tab. 

For materials that are defined in GeoDict’s Material Database, the density of the 

material is directly inserted under the Solid Density tab for that material ID. If 
multiple Material Laws are defined the desired one can be selected or a new one can 

be added by clicking on the name and then Open & Edit Material Database. 

If a material is not present in the GeoDict Material Database, it can be added in the 
Material Database and its properties are defined there. Alternatively, a material can 

be set to Manual, and its density can be entered under the Solid Density tab. Manual 
Laws are Material Laws for manual materials and can be added or deleted by clicking 

the “+” or “-“ button in the right column of the manual material. The corresponding 
values can be directly entered.  

The density of the solid materials can be given in kg/m3 or g/cm3 for all materials.  

The given Temperature value and the Temp. Range are only of importance if the 
solid density is defined as a temperature-dependent quantity in the GeoDict Material 

Database. For example, if Aluminum would be chosen as material, the solid density 
would be temperature dependent. 

More information on materials can be found in the Material Database handbook. 

 

In the above example, the densities of the PET and cellulose fibers are not set to be 
temperature dependent. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished. 

Be aware, that the reported Solid Grammage values are only meaningful if the whole 
thickness of the media is included in the domain. In the example on page 4, this is 

only true for the value in Z-direction.  
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THICKNESS ESTIMATION (1D STATISTICS) 

The Thickness Estimation (called 1D Statistics up to GeoDict 2023) command 
calculates the solid volume percentage (SVP) for each voxel layer perpendicular 

to the given direction (“through direction”).  

The user can select various types of fitting functions, 
Fit 1 to Fit 6, consisting of piecewise linear segments 

that best describe the type of porous media. For each 
selected fitting type, GeoDict solves an optimization 

problem to identify the best-fitting function. The 
thickness of the solid medium, of the inlet/outlet, and 
of the medium’s surfaces is then derived from this 

function. Furthermore, the SVP of these regions is 
computed. 

After clicking the Edit… button in the Options 
section, the Thickness Estimation dialog opens.  
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At the top of the dialog, enter the Result File Name. The result file with the given 

name is saved in the chosen project folder (File → Choose Project Folder in the 

menu bar). 

The parameters are organized into the Fitting Options and Minimizer Options tabs. 

The Equations & References tab, provides further information about the underlying 
algorithm. 

In the Background Mode pull-down menu, choose Pore to assign the material ID 
corresponding to pore space (“background”) and exclude it from the calculations. 
Alternatively, choose GivenID to assign one or multiple material IDs to the pore 

space (only for the calculations within Thickness Estimation) and select the material 
IDs from the Background MaterialID pull-down menu.  

In the Direction panel, one or more through directions for the thickness estimation 
can be chosen from the three principal directions. 

In the Fit Selection panel, one or multiple fitting types (Fit 1 to Fit 6) can be selected. 

In the Result Viewer, the selection can be change for post-processing calculations. 
This feature is particularly useful for comparing results across various fitting types. 

Additionally, to facilitate an easier selection, users can employ the Questionnaire, 
which automatically chooses fitting types based on the provided responses. 

More precisely, a distinction is made between media with a homogeneous density 

distribution (“Uniform”) and media with a density gradient (“Gradient”). 
Furthermore, either the absence (“Whole”) or presence of an inlet area and outlet 

area is considered. In the latter case, these areas can be non-empty, allowing for 
solids such as fibers to stick out of the medium. The transition between inlet and 
medium (and medium and outlet) can be approximated either by a sharp transition 

zone (“Sharp”) or by a smooth transition zone, which results in a non-zero surface 
length (“Smooth”). 

Fits 3 to 6 take an inlet/outlet area into consideration. If Write Inlet and Outlet to 
a .gdt-File is checked, the structure of the detected inlet and outlet is written to a 
file to a .gdt file in the project folder. 

Fits 5 and 6 assume that the medium begins at the center of the inlet area and ends 
at the center of the outlet area. This definition is modified by adjusting the Thickness 

SVP Threshold value, the technical specifics of which can be found in the tooltip. 

The following table gives an overview if and how the fits available in GeoDict 2023 

correspond to the new fits in GeoDict 2024.   

Fit in GeoDict 2023 Fit in GeoDict 2024 

Homogeneous media Fit 1 (Whole, Uniform) 

Gradient media Fit 2 (Whole, Gradient) 

- Fit 3 (Sharp, Uniform) 

- Fit 4 (Sharp, Gradient) 

Homogeneous media with non-empty inlet/outlet Fit 5 (Smooth, Uniform) 

Gradient media with non-empty inlet/outlet Fit 6 (Smooth, Gradient) 

Homogeneous media with inlet/outlet - 

Gradient media with inlet/outlet - 
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Note that, in GeoDict 2023, the fits for media with inlet/outlet layers with only 

background material are considered as inlet or outlet. This option is not available 
anymore in GeoDict 2024, instead you can specify in detail if the transition between 
media and inlet/outlet is sharp or not. 

 

The minimization method includes several numerical parameters that can be fine-
tuned under the Minimizer Options tab. Detailed information about these 

parameters is available in the tooltips and can also be found in the published 
document (see [1]). These options are intended for experts; the default values are 
generally suitable for common porous media.  

As an example, we analyze a 3D model of a structure with a side length of 1500 µm 
(1.5 mm) in Z-direction (2000 voxels · voxel length of 0.75 µm/voxel).To analyze the 

structure, we use the settings shown below. The results are shown in the next section 
where we explain the content of the result viewer. 
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RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished.  

In the Layer analysis section, the SVP of the entire structure is reported. In this 
example, the Z-direction was selected as through direction. Therefore, a Z direction 

analysis section is contained in the report. Initially, the specific solid volume and 
the specific pore volume are reported.  

Following this, a table displays computed values from the thickness estimation 

algorithm for the selected fits. The first three rows showcase the thickness of the 
identified inlet, medium, and outlet, with their cumulative sum equating to the domain 

size in the Z-direction. The fourth row provides the SVP of the identified medium. The 
nodes correspond to the piecewise linear approximations that are illustrated in the 
thickness estimation input dialog, which indicate the coordinate in the through 

direction and the corresponding SVP. The final row shows the error of the SVP 
approximation in the L2 norm. Below the table, the chosen thickness SVP threshold is 

reported. 

 

In the context menu shown on the left, the Fit Selection can be modified and 
executed as a post-processing step. Additionally, computations can be repeated with 
a different Thickness SVP Threshold value. Click Apply… to update the Report, 

the Plots, and the corresponding results Map. 
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In the Plots tab, the SVP distribution corresponding to the layers of the through 

direction, their piecewise linear approximation, and the estimated medium thickness 
are visualized under the Approximation subtab for each selected fit. If exactly two 
fits are selected, two stacked plots will be displayed for comparison purposes. 

Otherwise, if three or more fits are chosen, you can select the plot you wish to view 
from the pull-down menu. 

 

Furthermore, under the Material subtab, plots of the SVP of all existing materials are 

shown: 
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Under the Material ID subtab, plots of the SVP of the different materials IDs are 

shown. The plots differ only from those in the Material subtab if several material IDs 
are assigned to the same material. 

 

DATA VISUALIZATION 

Under the Data Visualization tab, a structure showing the identified inlet/outlet 
regions can be loaded. The inlet and outlet areas are calculated based on the 

measured SVP and the selected methods. If multiple methods with inlet/outlet are 
selected, a structure is saved for each of those methods. 

 

The inlet/outlet volume is assigned to Material ID 02 (here green) and the entire solid 
structure is assigned to Material ID 01 (here red). Intersections (“overlap”) of the 

structure’s fibers and the identified inlet/outlet volume are assigned to Material ID 03 
(here yellow). 
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2D DENSITY MAP 

The 2D Density Map command calculates the distribution of Grammage, Solid 
Volume Fraction (SVF) or the Number of Objects in a plane normal to the chosen 

direction. Each pixel in this plane is calculated by averaging the respective property 
in the direction of interest at this position.  

 

The 2D Density Map dialog opens when clicking the Options’ Edit… button. It 

contains two tabs: Statistic Options and Material Density. 

At the top of the dialog, enter the Result File Name. The result files are saved in the 

chosen project folder (File → Choose Project Folder in the menu bar). 

STATISTIC OPTIONS 

Under the Statistic Options tab, choose the property to be computed from the 
Compute Map for pull-down menu. 

Only when choosing Grammage, the Material Density tab is selectable and the 
density values for the individual Material IDs can be defined. For Solid Volume 
Fraction or Number of Objects, the density of the material IDs is not considered in 

the calculations and the Material Density tab therefore not needed.  

When choosing Number of Objects, analytic information about the objects in the 

current structure must be available. Otherwise, a warning message appears, and the 
density map cannot be computed.  
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The choice in the Compute Statistics for pull-down menu controls whether the 

property is computed for All Solid Materials or only for Selected Material IDs.  

 

For Selected Material IDs, those can then be chosen from the materials present in 
the structure in the Choose Material IDs pull-down menu. 

Check Compute in X-direction, Compute in Y-direction, and/or Compute in Z-

direction to calculate the chosen properties in these directions. 

From the Raster Length pull-down menu, choose Voxel Length or Given Length. 

This defines the side length of square areas in which Grammage, Solid Volume 
Fraction, or Number of Objects are computed.  

Voxel Length sets the raster length equal to the voxel size and, thus, the 2D density 

map is computed in the chosen directions for each voxel. If Given Length is chosen, 
the Length in units of voxel must be entered to define the resolution for the 

calculations.  

The following figures show the effect of the Raster Length on the results:  

The left picture shows the result for Voxel Length, the right picture the result for a 

Given Length of 10 voxels. 

 

Histogram Bins refers to the number of bins used to divide the range of density 

values (Grammage, Solid Volume Fraction, or Object Number) into a series of equally 
sized intervals. In the result file, the number of histogram bins is used to create tables 
and plots with the frequency (probability) of values that fall into each interval.  

For example, the following plots are taken from result files for the same structure. In 
the left figure, the histogram is shown with 20 bins, and in the right figure with 10 

bins.  
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MATERIAL DENSITY 

If Grammage is chosen as the computed material property, the density of every 
material in the structure must be specified under the Material Density tab. For 

materials from the GeoDict Material Database, the density value is entered 
automatically. If not, manual data can be entered as described on page 5. 

 

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished.  

In the Results - Report tab, a table shows the computed density distribution. The 
report table also states the minimal, maximal, and mean values of the computed 

parameter (here: Grammage) and the standard deviation.  
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In the Results – Plots tab, the table entries are additionally available as a 

Histogram plot. The 2D Density Map subtab shows the computed result. 
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3D INHOMOGENEITY 

The 3D Inhomogeneity command calculates the distribution of the Solid Volume 
Fraction, Solid Density or Porosity in specified sub-volumes. Each sub-volume is 

a cube with a side length that can be specified by the user.  

 

The 3D Inhomogeneity dialog opens when clicking the Options’ Edit… button and 

includes the Statistic Options and Material Density tabs. 

At the top of the dialog, enter the Result File Name. The result file is saved in the 

chosen project folder (File → Choose Project Folder in the menu bar). 

STATISTIC OPTIONS 

Under the Statistic Options tab, choose the property to be computed from the 3D 
Inhomogeneity Mode pull-down menu.  

 

Only when choosing Solid Density, the Material Density tab is selectable 
afterwards and the density values for the individual Material IDs can be defined.  

For Solid Volume Fraction or Porosity, the density of the material IDs is not 
considered in the calculations and the Material Density tab therefore not needed.  
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The choice in the Compute Statistics for pull-down menu controls whether the 

property is computed for all materials (Pore and Solid) or only for specified materials 
(Chosen Material) or for Chosen Material IDs.  

 

After the selection of Chosen Material IDs, the IDs can be chosen from the materials 
present in the structure, which appear under the Choose Material IDs pull-down 

menu. 

 

The Raster Length determines the side length of the cubic sub-volume in voxels. If 

Raster Length is not a common divisor of the side lengths NX, NY, NZ of the current 
structure, some boundary layers of the current structure will not be contained in any 
sub-volume. In this case, a warning will be plotted in the result viewer. 

MATERIAL DENSITY 

If Solid Density is chosen as the material property to be computed, the density of 
every material in the structure must be specified under the Material Density tab.  
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For materials from the GeoDict Material Database, the density value is entered 

automatically. Otherwise, see page 5 how to edit the density. 

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 

to start the structure analysis. The result file (*.gdr) is shown in the Result Viewer 
after the computation is finished. 

 

In the Results - Report subtab, the minimal and maximal value of the chosen 

property found in any sub-volume are reported. Additionally, the mean value and the 
corresponding standard deviation are shown. 

In the Results – Plots subtab, a histogram of the Count Probability of the selected 

property is plotted. 
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DATA VISUALIZATION 

Under the Data Visualization tab, it is possible to visualize the computed densities, 
porosities, or solid volume fractions of the sub-volumes. Clicking on Load Solution 
File loads the result field. 
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MATERIAL CHARACTERIZATION 

SOLID SIZE DISTRIBUTION (GRANULOMETRY) 

After selecting Solid Size Distribution (Granulometry), the needed parameters 
can be entered by clicking the Options’ Edit… button.  

 

The Solid Size Distribution dialog includes the Solid Size Options and the Material 
Density tabs. The last tab, Equations & References, provides further information 
about the underlying algorithm. 

At the top of the dialog, enter the Result File Name. The result file is saved in the 
chosen project folder (File → Choose Project Folder in the menu bar). 

SOLID SIZE OPTIONS 

The Solid Size Options are similar to those of PoroDict’s Pore Size Distribution 
(Granulometry). For details refer to the PoroDict handbook. Be aware, that Write Pore 

Geometries as *.gdt Files and the settings for fluid in pores is not available here as 
the material for the solids is already defined.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PoroDict&release=2024&heading=GeometricPSD
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MATERIAL DENSITY 

Under the Material Density tab, the temperature can be edited if the density of a 
material is temperature dependent. Additionally, the density of every solid material 
in the structure must be specified in this tab. For materials from the GeoDict Material 

Database, the density value is entered automatically. Otherwise see page 5 how to 
edit the density. 

 

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished. 

 

Under the Results - Report subtab, the Characteristic Diameters are shown. For 
example, here, the D10 value of 8.55 µm means that 10% of all solids have a smaller 

diameter than 8.55 µm. The D50 value of 18.03 µm means that 50% of all solids have 
a diameter smaller than 18.03 µm, and the D90 value of 19.71 µm means that 90% 
of all solids have a diameter smaller than 19.71 µm.  
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The discretization error is less than 1 voxel, which means for the presented example, 

that the D10 is 8.55 µm ± 1.0 µm. 

Below the characteristic diameters, a table contains Maximum and Minimum 
Diameters, Volume Fraction, Cumulative Volume Fraction, the Solid Volume, and the 

Differential Solid Volume Distribution for every bin. Also, at the bottom of the Report 
tab, the total solid volume percentage of the structure is shown. 

Under the Results – Plots subtab, different relative and cumulative histograms can 
be plotted. The histogram of interest, i.e. Volume, Volume Fraction, or 
dV/d(log(Diameter)) can be chosen in the Volume Histogram Plot section.  

 

The differential pore volume distribution 𝑑𝑉/𝑑(𝑙𝑜𝑔(𝑑𝑖𝑎𝑚𝑒𝑡𝑒𝑟)) is then computed as  

𝑉𝑐𝑢𝑚(𝑑𝑖+1) − 𝑉𝑐𝑢𝑚(𝑑𝑖)

(log⁡(𝑑𝑖+1) − log⁡(𝑑𝑖)) ⋅ 𝑚
(1) 

with 𝑑𝑖 the pore diameter of the i-th bin, 𝑉𝑐𝑢𝑚 the cumulative volume fractions, and 𝑚 

the mass of the structure. The latter is computed using the densities of the solid 
constituent materials of the sample. This normalization ensures that the value of 
dV/d(log(Diameter)) is independent of the domain size. 

After choosing and clicking Apply…, the plots on the right hand-side change 
accordingly.  
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In the Cumulative Histogram plot, the red curve shows the volume fraction of solids 

smaller than a given diameter and the blue curve shows the solids larger than or 
equal to a given diameter. Both curves sum up to 100% for any given diameter.  

 

Finally, the Results - Map subtab gives access to the values of the computed 
parameters.  

 

SOLID SIZE VISUALIZATION 

The distribution of solids is observed in the Volume Fraction/Solid Diameter plot but 
can also be visualized through the Solid Size Visualization tab. When Write Solid 
Size Distribution as *.gsd File was checked before running the command, it is 

possible to visualize the size distribution by clicking Load GeoDict Size Distribution 
(*.gsd).  

 

To see the solid size distribution inside of the structure, it is recommended to 

deactivate the visualization of the structure itself. This can be done by unchecking 
Structure in the tab headers or alternatively in the View settings. Additionally, the 
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visualization of the result field in the pore space (where the value is always zero) can 

be deactivated by unchecking all pore materials with the option Visible on Material 
IDs under the Volume Field tab. 
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PERCOLATION PATH 

The Percolation Path command is accessible from MatDict and PoroDict. It can find 
the shortest percolation paths of maximal diameter in the pore space or through a 

given material. Two voxels of a percolation path are connected if they share a common 
face. Thus, the neighborhood mode is always ‘Face’. 

 

The Percolation Path dialog opens, and the necessary parameters can be entered by 

clicking the Options’ Edit… button.  

At the top of the dialog, enter the Result File Name. The result files are saved in the 

chosen project folder (File → Choose Project Folder in the menu bar).  

 

The Computation Direction defines the direction in which the percolating path 
should cross the structure.  
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Material to Analyze defines through which materials the path may run. Four options 

are available:  

 

Pore Space finds a percolation path through the pores, All Solid Materials through 
the solids. Chosen Material allows to choose a single material. The last option, 

Chosen Material IDs, gives the full flexibility to select a list of material IDs where 
the path may run through.  

The number of percolation paths to be detected is set with the Number of Paths 
parameter. Then, the algorithm computes the n best percolation paths. 

The diameter of pores and solids near the domain boundary is strongly influenced by 

the selected Domain Boundary Conditions. Here, the same boundary conditions as 
in the granulometry command are available. An example explaining the available 

options is given in the PoroDict handbook in the section of the Pore Size Distribution 
(Granulometry) command. 

Search Periodic Path is only available for periodic boundary conditions. If checked, 
the Percolation Path is allowed to cross lateral periodic boundaries. Using this option 
increases computation time. A periodic percolation path is not necessarily periodic in 

the computation direction.  

From the Diameter Mode pull-down menu, choose to detect percolation paths with 

the Maximal Diameter possible or Specify Maximal Diameter and enter a 
Maximal Diameter value below.  

To run the calculations in High Resolution might be useful when the path space is 

expected to be narrow. The standard algorithm computes distances directly on the 
voxel grid, i.e. when determining a pore size, only the distances from the center of a 

pore voxel to the center of a solid voxel are taken into account. High Resolution also 
takes the voxel surfaces and edges into account, so the computed distances 
correspond to the distance to the next surface or edge. The disadvantage of the High 

Resolution mode is that the calculation runtime and memory usage may increase by 
a factor of eight.   

If the largest computed path is smaller than five voxel lengths, and the simulation 
was run in the standard mode, a warning message is shown. In this case, it is 
recommended to re-run the simulation in High Resolution mode. 

 

When Save Center-Line is checked, the results folder additionally contains *.gdt 

files with the centerline of the computed percolation paths.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PoroDict&release=2024&heading=GeometricPSD
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With Optimize Path, the length of the percolation path is optimized after the 

calculation. This shortens the calculated path by removing voxel staircase artifacts: 
The algorithm for the percolation path works on the voxel structure and can therefore 
only find paths which run directly through connected voxels. Therefore, the default 

method might not always find the best path in structures with large open pores. In 
these cases, it is recommended to select Optimize Path (see the examples below). 

 

Click OK to close the Percolation Path dialog and start the command by clicking Run. 
The Result Viewer automatically opens at the end of the calculations. 

RESULTS 

The Results - Report subtab includes the Maximum Particle Diameter (in µm and 
voxels) of spherical particles which may pass through the medium, as well as the 

Path Length (in µm and voxels) of the detected percolation path(s).  

 

Under the Data Visualization tab four options are available.  

Structure without a path 
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To show the Voxel Geometry with Percolation Path(s) click Load *.gdt.  

The Analytic Percolation Path(s) Geometry can be loaded by clicking the Load 

*.gad button and shows only the percolation paths without the structure. 

 

The option Center Line Geometry is only available if Save Center-Line was 
activated when running the simulation. It loads a structure file that contains the 

center line of the path with the maximal diameter. 

 

The Percolation Path(s) Trajectories can also be visualized with animated spheres 
moving through the structure. For this, click Load Particles. Deactivate the structure 
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visualization by unchecking the Structure tab in the Visualization panel, above the 

Visualization area.  

 

In the Visualization panel, click Play under the Particles tab. For convenience, check 
Loop and, for the Trajectories, select to show all. 

 

In this example, you can observe four spheres (here green) corresponding to the four 

percolation paths moving through the volume. 
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CONNECTED COMPONENTS 

With the Connected Components command, it is possible to find and count the 
number of connected components in the 3D structure. A connected component 

consists of all voxels that are in contact with each other, and which belong to the 
same phase, the same material, or the same material ID.  

 

The Connected Components dialog opens when clicking the Options’ Edit… button 
and includes the General Options and the Post-Processing tabs.  

 

At the top of the dialog, enter the Result File Name. The result file is saved in the 
chosen project folder (File → Choose Project Folder in the menu bar). 

GENERAL OPTIONS 

In the Periodicity panel, periodic boundaries can be set in the three spatial 

directions. If the box is checked, every voxel located on the boundary of the domain 
is connected to a voxel on the opposite side of the domain. Thus, components can be 
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connected across the domain boundary. If the box is not checked, no connections 

exist across the domain boundary. 

If the Component Mode is set to Material ID, all voxels belonging to one component 
must have the same material ID. If it is set to Material, all voxels belonging to one 

component must belong to the same material. If it is set to Pore / Solid, the 
distinction happens only between solid or pore voxels. Thus, in the Pore / Solid 

mode, voxels with different material IDs may form one component. For the user’s 
convenience, all material IDs which denote pore space are shown at the bottom of 
the dialog.  

 

While the Component Mode defines which parts may belong to one component, with 
Count Components for set what is counted and reported. Select if pore and/or solid 
components are counted. Dependent on the selected Component Mode, it is also 

possible to count components only for a specific material or for specific material IDs. 

 

The meaning of ‘connected’ is defined in the Neighborhood Mode panel. Voxels can 

be connected through faces, edges, and corners (vertices).  

 

The two red voxels share a face, the green voxels share an edge, and the blue voxels 
share a vertex. In Voxels sharing a face mode, the two red voxels form one 

component, the green voxels form two components, and the blue voxels form two 
components. In Voxels sharing a face, edge mode, the red voxels form one 

component, and the green voxels form one component, while the blue voxels still 
form two components. In Voxels sharing a face, edge, vertex mode, the red voxels 
form one component, the green voxels form one component, and the blue voxels form 

one component. 

When checking Write Voxel Geometry with Component Indices (*.g32), the 

connected components are saved as objects in a .g32 file. This file can be opened in 
GeoDict, GeoPy or GeoLab.  
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When checking Write Voxel Geometry with Component Indices (*.leS), the 

object indices are stored in an *.leS ASCII file. This file is human readable, but will 
be considerably larger and slower to read than the *.g32 file. Therefore, it is 
recommended to use the *.g32 format. 

POST-PROCESSING 

Under the Post-Processing tab, the settings used to create the histogram of the 
analyzed components are defined. It is possible to modify those settings after the 
computation has been run in the result viewer. The explanation of the input 

parameters is therefore given in the Results section below.  

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished. 

The left panel of the Results tab, can be collapsed (and expanded) by pulling left (or 
right) the dotted line between the post-processing options and the Results – Report 

subtab. 

Under the Results - Report subtab, the information about the Number of 3D 
components, Number of components per 2D-slice, The component volume 

and the Object volume histogram is given. 

 

The object volume histogram is also shown under the Results - Plots subtab. In the 
plot, the values for each bin are visualized as bars.   

As a post-processing step, the settings of the object volume histogram are adjusted 
and changed on the left-hand side panel, which can be expanded and collapsed as 
explained above. Edit the options and click Apply to fit values in the Results tabs.  

The options are the same as the ones available under the Post-Processing tab in 
the Connected Components dialog. 

The X-Axis pull-down menu allows choosing whether the components should be 
classified based on volume (Volume) or based on volume equivalent sphere diameter 
(Equivalent Diameter). 
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For the Y-Axis pull-down menu, the Relative Count Probability provides the 

number of components in each bin normalized to the total number of components.  

 

The Cumulative Count Probability is the sum of the Relative Count Probability over 
all bins starting from the smallest bin. Relative Volume Probability gives the 

volume of the components within one bin normalized to the total volume of all 
components. The Cumulative Volume Probability sums up the Relative Volume 

Probability of each bin of the histogram starting from the smallest one. 

The histogram Mode offers the choice between generating an Automatic Histogram 
without further specifications or to Give Min. and Max Value for the parameter 

defined in the X-Axis pull-down menu (Volume or Equivalent Diameter). Either Min. 
Volume and Max. Volume or Min. Diameter and Max. Diameter can be directly 

entered here. 

The number of Histogram Bins determines the number of rows in the Object 

Volume Histogram table. 

The table and plot are updated when the Apply… button is clicked after changing the 
Volume Histogram input parameters. 
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Under the Plots tab, also the computed Number of Components per 2D Slice is 

visualized by three graphs, which are selectable in the drop-down menu. 

 

The Results-Map subtab additionally contains an overview of the computed 
parameters, such as component volume, number of 2D components in each direction 
and mean values of each. Moreover, the details for every found component are given: 

▪ VoxelCount states the number of voxels inside of a component. 

▪ SeedVoxel is an arbitrary voxel inside of this component. 

▪ IsPore states if this component is pore or solid. 

▪ Counted states if this component is counted. 
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DATA VISUALIZATION 

The detected connected components can be visualized in the GeoDict visualization 
area in two different ways.  

 

The first two options load the index image in *.g32 or *.leS format. These are 3D 

images, where for every voxel the index number of the corresponding component is 
stored. For example, if the structure consists of 1027 components, the file will contain 

numbers from 1 to 1027. Click Load *.g32 or Load *.leS to load the index image. 

After clicking OK in the appearing dialog, the Visibility Options dialog pops up.  

 

For the visualization of the index image, it is recommended to set the structure 

visualization to invisible by clicking Yes, so that the indices can also be seen in the 
solid parts of the structure.  

In the index image visualization, every index is highlighted with a different color. The 
example below shows the index image of a closed-cell foam in 2D, where every cell 
of the foam belongs to another connected component of the pore space.  
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The third option is to load the components as a structure file in GeoDict’s *.gdt file 

format. Every component is assigned a material ID based on the index number as 
shown in the following picture. 

 

Be aware, that this format supports only 256 different material IDs. This might lead 

to neighboring components getting assigned to the same ID. In the example, every 
255th foam cell gets assigned to the same ID as the cell walls, and therefore 

disappears in the visualization.  
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ESTIMATE SURFACE AREA 

With Estimate Surface Area, the surface area of the structure is estimated with a 
method based on statistical measures. The Estimate Surface Area options open 

when clicking the Options’ Edit… button.  

 

At the top of the dialog, enter the Result File Name. The result file is saved in the 

chosen project folder (File → Choose Project Folder in the menu bar). 

Calculations can be parallelized if the user’s license and hardware allow it. The 

Parallelization Options dialog opens when clicking the Edit... button, to choose 
between Local, Sequential, Local, Parallel or Local, Maximum. 

 

When Local, Parallel is selected, the number of Threads can be entered. Then the 

maximum number of available processors and the maximum number of licensed 
parallel processes is shown in the dialog. 

Under Surface Mode choose the materials or material IDs for which the surface area 

should be calculated. The surface is defined as the boundary between the chosen 
materials (material IDs) and all other materials (material IDs) or between two given 

materials (material IDs). 

Pore Space computes the surface of the pore space, which is the union of Pore and 

all Fluid materials. It returns the same result as All Solid Materials, which computes 
the surface of all solid and porous materials combined to one material. Especially, All 
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Solid Materials does not include the inner surfaces between different solid materials 

or material IDs.   

If Chosen Material or Chosen Material ID is selected, choose the desired material 
(material ID) from the pull-down menu that appears below.  

 

For the surface modes Between Materials and Between Material IDs select the 

two materials (material IDs) to be considered for the surface area. 

 

Selecting Periodic, the algorithm estimates the surface area assuming that the 
structure is periodic, so that the material that ends on one side of the volume 
reappears on the opposite side.  

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 

to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished. 

These values include the Number of voxel surfaces, the Surface area, and the 

Specific surface area, defined as the Surface Area normalized by the total volume 
of the structure.  

Algorithm 1 computes the surface area by adding up the voxel surfaces.  

Algorithm 2 estimates the real surface area, originating from statistical image 

analysis, where the determination of the four Minkowski measures (Volume, Surface 
Area, Integral of mean curvature, Integral of total curvature, see also [2]) from 
voxelized images is an essential task.  

Algorithm 2 uses a staggered grid, which means it uses the voxel centers of the 
original grid as corners. In this grid, half a voxel cell is left over on each side. When 

using Periodic boundary conditions, those half-cells are completed across the domain 
boundary again to full grid cells, and this way the whole volume is taken into account. 
Without periodic boundary conditions, these half-cells are discarded. This means, that 

without periodic boundary conditions half a voxel is cut away on every side, so a 
slightly smaller volume is considered when computing the specific surface area. 
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ESTIMATE THREE-PHASE CONTACT LINE 

With Estimate Three-Phase Contact Line, the length of the contact line between 
the phases in a three-phase system and the number of voxel edges of the contact 

line in the cartesian directions can be computed. The Estimate Three-Phase 
Contact Line options are opened by clicking the Options’ Edit… button.  

 

At the top of the dialog, enter the Result File Name. The result file is saved in the 

chosen project folder (File → Choose Project Folder in the menu bar). 

Through the Material ID 1, Material ID 2, and Material ID 3 pull-down menus, 
the three-phase material IDs for which the Three-Phase Contact Line length should 

be computed are selected.  

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished. 

In this algorithm, all voxel edges are found that are adjacent to all three materials.  

The report contains the computed values for Number of voxel edges in x-, y-, and 

z-direction, as well as the Total length of three-phase contact edges, which is 
computed by multiplying the sum of the above numbers with the voxel length. 
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MINKOWSKI PARAMETERS 

To compute the Minkowski Parameters (Volume, Surface Area, Integral of mean 
curvature, Integral of total curvature), the needed parameters can be entered by 

clicking the Options’ Edit… button.  

 

At the top of the dialog, enter the Result File Name. The result file is saved in the 
chosen project folder (File → Choose Project Folder in the menu bar). 

 

Calculations can be parallelized if the user’s license and hardware allow it. The 

Parallelization Options dialog opens when clicking the Edit... button, to choose 
between Local, Sequential, Local, Parallel or Local, Maximum. 
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When Local, Parallel is selected, the number of Threads can be entered. Then the 

maximum number of available processors and the maximum number of licensed 
parallel processes is shown in the dialog. 

Compute for Material ID defines the Material ID for which the Minkowski 

Parameters are computed. 

Selecting Periodic, the structure is assumed to be periodic, so that the material that 

ends on one side of the volume reappears on the opposite side. Otherwise, symmetric 
boundary conditions are used. 

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 

after the computation is finished. Under the Results-Report subtab the four 
Minkowski Parameters characterize the mathematical topology of the structure: 

◼ The parameter Volume is the volume occupied of the chosen Material ID. Its 

percentage is also given by Volume Fraction. 

◼ The Surface area is the boundary between the chosen Material ID and all other 

Material IDs. It is computed as in Algorithm 2 of the Estimate Surface Area 
command (see also [2]). 

◼ The Integral of mean curvature describes the mean curvature of the selected 
Material ID, given by the following formula: 

𝐶𝑀(𝑋) =
1

2
∫ 𝑘1
𝛿𝑋

+ 𝑘2⁡d𝑠 =
1
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𝑟1(𝑠)𝛿𝑋

+
1

𝑟2(𝑠)
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◼ And the Integral of total curvature describes the total curvature of the selected 

Material ID: 

𝐶𝑇(𝑋) = ∫ 𝑘1
𝛿𝑋

𝑘2⁡d𝑠 = ∫
1

𝑟1(𝑠)𝑟2(𝑠)𝛿𝑋

⁡d𝑠 (3) 

where X is the chosen material ID, s is a surface element of the chosen Material ID 

and the parameters 𝑟1(𝑠)  and 𝑟2(s)  are defined as the radii of the two principal 

curvatures 𝑘1 and 𝑘2 from the respective surface element. 

 

The surface area and the curvature values are given additionally as specific values, 
which are normalized by the total volume of the structure. 

𝑘1 

𝑘2 

surface element 𝑠 
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The Euler characteristic (E) is a topological number, that describes to what extent 

the structure is connected. It equals 
1

4π
 times the integral of total curvature. This 

results in E  =  N − L + C, where N is the number of objects, L is the number of loops 

and C is the number of cavities. 

 

The screenshot shows the computed Minkowski parameters for the pore space (here 

material ID 00, on the left), and the solid material (ID 01, right) of the structure 
shown above.  
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CHORD LENGTH DISTRIBUTION 

The Chord Length Distribution command is accessible from MatDict and PoroDict. 
The Chord Length is defined as the number of connected voxels along the 

computational direction. Pseudo-code of the algorithm used for the computation can 
be found in [2]. After selecting Chord Length Distribution from the pull-down 
menu, the settings for the calculations can be modified through the Edit… button.  

 

At the top of the dialog, enter the Result File Name. The result file is saved in the 

chosen project folder (File → Choose Project Folder in the menu bar).  

 

Calculations can be parallelized if the user’s license and hardware allow it. The 
Parallelization Options dialog opens when clicking the Edit... button, to choose 

between Local, Sequential, Local, Parallel or Local, Maximum. 

When Local, Parallel is selected, the number of Threads can be entered. Then the 
maximum number of available processors and the maximum number of licensed 

parallel processes is shown in the dialog. 
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In the Chord Length Distribution dialog, choose the material ID of the material 

(Chord MaterialID) for which the chord length distribution is to be calculated. This 
can be done for pore or solid materials alike.  

In the Chord Directions section, select the direction(s) in which the chord lengths 

are determined. This can be done along the axes (Direction X, Direction Y or 
Direction Z), along the two-dimensional diagonals (All face diagonals), or along 

the three-dimensional diagonals (All volume diagonals). 

Periodicity can be applied in the X-, Y-, and/or Z-direction for the calculation. 
Periodicity means, that chords continue on the opposite side of the domain. This can 

lead to infinitely long chord lengths, if a complete ray along the chosen direction is 
inside of the selected Chord Material ID. Such chords are neglected when computing 

the distribution results, and a warning is plotted on top of the resulting report if this 
occurs:  

 

Check Per-voxel chord length computation for the output to include a scalar field 

in which, for each voxel, the length of the minimum or maximum chord through that 
voxel over all chosen directions is stored. For this, choose between Minimum over 

chosen directions or Maximum over chosen directions. 
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RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 
to start the structure analysis. The Result Viewer opens at the end of the calculation. 

Due to the voxelization, the chord length can only be measured in multiples of the 

voxel length. A chord length of d meters includes all chord lengths with a distance of 
half the voxel length around d. For example, a chord length of 2µm with voxel length 

1µm actually means all chords between 1.5µm and 2.5µm. 

Under the Report tab, the Mean chord lengths, the Fraction lengths L10, L50, 
L90 and P10, P50, P90 in the selected chord direction(s), and the complete Chord 

length distribution in the selected direction(s) is shown. The fraction lengths table 
reports the chord lengths smaller than 10%, 50%, 90% of all chord lengths (L10, 

L50, L90). The  P-values (P10, P50, P90) are  the same, but rounded up to the next 
largest multiple of the voxel length. 

 

For example, a L10 of 2.6 µm means that 10% of all chords are smaller than this 

length. A L50 of 17.4 µm means that 50% of all chords are smaller than this length. 
A L90 of 58.6 µm means that 90% of all chords are smaller than this length.  

For P10 the L10 value of 2.6 is rounded up to 3e-6 and means that this length (3 µm) 
is larger than or equal to the length of 10% of all chords. A P50 of 1.8e-5 means that 

this length (18 µm) is larger than or equal to the length of 50% of all chords. A P90 
of 5.9e-5 means that this length (59 µm) is larger than or equal to the length of 90% 
of all chords. 

The plot of the computed chord length distribution appears under the Results-Plots 
subtab. 
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In the context menu shown on the left, the chord length distribution plot can be 
customized. For the Y-Axis, the Cumulative Number, the Normalized Number, 

or the Number of Chords can be selected.  

 

The normalized number of chords is the difference quotient of the cumulative chord 
length distribution, where the step size is the current voxel length.  

Alternatively, the normalized number of chords can also be obtained from the number 
of chords histogram. For example, the normalized number of chords in X-direction 

can be computed as follows: First, the number of chords is divided by NY*NZ, which 
equals the total number of rays, to obtain the number of chords per ray. Then, this 
number is normalized by NX*voxel length to obtain the number of chords per meter. 

As the accuracy of the measurement of the chord length is restricted by the voxel 
length, the histogram bin size is also given in voxels. To reflect this, the number of 

chords per meter must again be divided by the voxel length (which equals the bin 
size) in the last step. This allows to compare results for structures with different voxel 
lengths. 

In addition, if more than one direction was chosen for the computations, it can be 
chosen for which directions the distribution should be shown (Main Directions, Face 

Diagonals, Volume Diagonals).  

Click Apply… to update the shown plot. 

DATA VISUALIZATION 

By clicking the Load button under the Data Visualization tab, the corresponding 
per voxel chord length can be loaded and visualized over the structure, if Per-voxel 

chord length computation was previously checked (see page 48).  
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GEODESIC TORTUOSITY 

The Geodesic Tortuosity command is accessible from MatDict and PoroDict. It 
computes the tortuosity of paths crossing the material, either through pore space or 

through solid materials. 

 

At the top of the Geodesic Tortuosity dialog, enter the Result File Name. The 
result file is saved in the chosen project folder (File → Choose Project Folder in the 

menu bar). 

 

Set the direction of the paths by selecting the Computation Direction.  

The algorithm searches for paths in the selected Material to Analyze, either Pore 
Space, All Solid Materials, Chosen Material, or a list of Chosen Material IDs. 

Paths might leave the domain and enter again on the opposite side if Periodicity is 
selected for this direction. The chosen computational direction cannot be chosen to 
be periodic. The option Optimize Paths is explained on page 30. 

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 

to start the structure analysis. The Result Viewer opens at the end of the 
calculation. 
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For every voxel on the outflow plane, the algorithm finds the shortest path through 

the selected Material to Analyze. The corresponding geodesic tortuosity is then 
computed as 

τ =  
shortest path to inflow plane

distance to inflow plane
(4) 

In the Report tab, the minimal, maximal, and mean geodesic tortuosity are shown. 

The corresponding minimal and maximal path lengths and the mean length of all 
paths are also given. 

 

DATA VISUALIZATION 

When clicking the Load button under the Data Visualization tab, the scalar 

geodesic tortuosity field is loaded. It contains for each voxel inside the selected 
material the shortest path distance between this voxel and the inflow plane. 
Therefore, on the inflow plane all voxels contain the value 0. Shown below are voxels 

on the outflow plane, where the voxel values show the computed path lengths as 
given above. Their local distribution around the mean value of 501 µm can be 

observed.  
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2-POINT CORRELATION 

The 2-Point Correlation command computes the probability for two points having a 
certain distance to be correlated, which means that they belong to the same type.  

The 2-Point Correlation dialog opens when clicking the Options’ Edit… button. 

 

At the top of the 2-Point Correlation dialog, enter the Result File Name. The result 
file is saved in the chosen project folder (File → Choose Project Folder in the menu 

bar). 

Next, decide to Compute Correlation for either Pore and Solid, Chosen Material 
or Chosen Material ID.  

Using the mode Pore and Solid, two points are positively correlated if they both 

belong to Pore or both belong to Solid. They are negatively correlated if one point 
belongs to pore and the other to solid. 

For Chosen Material two points are positively correlated if they belong to the same 
material. They are negatively correlated if the two points belong to different materials. 

For Chosen Material ID two points are positively correlated if they have the same 

Material ID. They are negatively correlated if they have different Material IDs. 

To find the probability distribution for different distances, several samples of point 

pairs for each distance are generated. The Number of Samples can be entered in 
the dialog and the Random Seed can be specified. For different random seeds 
different randomly chosen points are compared if they belong to the same type. If 

yes, the autocorrelation value is 1, otherwise -1. For distance 0, the correlation is 
always 1, since a voxel has always the same Material ID as itself. Then for each 

distance an average probability is computed, which is more accurate the more 
samples are taken.  

The Maximal Length Scale/(Voxel) defines the largest distance for which the 

probability is computed.  
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The distance can be measured either in X Direction, Y Direction or Z Direction or 

in all three directions by choosing Isotropic.  

 

If Periodic is chosen, the structure is assumed to be periodic in the chosen 
computational directions. Thus, the autocorrelation repeats periodically for distances 

larger than the domain size. If Periodic is not checked, only distances smaller or equal 
than the domain size in the computational direction are allowed. If Isotropic is chosen 

as direction, the distance is not allowed to be larger than the smallest domain length. 

RESULTS 

Click OK to input the entered parameters, and then click Run in the MatDict section 

to start the structure analysis. The Result Viewer opens at the end of the calculation. 

In the Results – Report tab a table shows for each distance the computed 

autocorrelation of two points having this distance. At the bottom, the Correlation 
Length in voxel is given.  

In the Report – Plots subtab the values from the table are graphically shown. 
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In the example below, a structure with bars of width 10µm each and space of 10µm 

between them is shown. The voxel length is 1µm and the structure has a size of 
100x1x100 voxel. The 2-point correlation is computed in X Direction and with a 
maximal distance of 100 Voxel. Compare the results with and without Periodic 

checked. 

 

 

 



GAD Objects Analysis – Analyze Objects 

GeoDict 2024 User Guide  57 

GAD OBJECTS ANALYSIS 

ANALYZE OBJECTS 

With the Analyze Objects command, it is possible to analyze the geometrical objects 
forming the 3D micro-structure, e.g. fibers, spheres or ellipsoids, and how they are 

in contact with each other. Therefore, this command requires that the structure is not 
only described by a voxel grid, but also that the underlying analytic Object Data is 
available.  

 

The Analyze Objects dialog opens when clicking the Options’ Edit… button and 

includes the Object Data and the Analyze Options tabs. 

At the top of the dialog, enter a name for the Result File Name. 

OBJECT DATA 

The necessary geometrical information, required by the analysis can be taken from 

two different sources: 

1. The information is already available for the current 3D structure.  

If this is the case, a green dot is displayed in the GAD Objects row in the 
Project Status section, at the left of the GUI. 

 

To use the current object information, set Object Data to Use Current GAD 
Structure. 
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2. The second option is to use an Index Image (*.g32 File).  

This file type might be the result of object analysis commands in GeoDict, e.g. 
MatDict’s Connected Components analysis.  

To use this option, a *.g32 file must be loaded as Volume Field. Then set Object 

Data to Use Current Index Image. 

Additionally, the periodicity may be chosen 

 

ANALYZE OPTIONS 

In the Material Mode pull-down menu, choose Analyze All Material IDs to analyze 
all materials present in the structure, or select Analyze Selected Material ID to 

analyze only one material. This material ID must be chosen from the corresponding 
pull-down menu.  
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The number of GAD objects and their overlap percentage are computed. Additionally, 

a *.gdt file with the objects and their overlaps is written and saved as 
ObjectsAndOverlap.gdt in the result folder. 

When Analyze Object Contact is checked, the number of contacts, the contact area, 

and the mean coordination number are computed. 

When Analyze Object Volume is checked, the volume of each object is computed, 

and a histogram of all object sizes is created. The parameters in the panel below the 
checkbox describe the settings for the object volume histogram plot. They can be 
changed in the post-processing step and are explained in the Results section below.  

If Use Current GAD Structure is selected in the Object Data tab, the following 
options are available under the Analyze Options tab: 

When checking Write Object Orientation (*.gof), the data on the orientation of 
the objects is saved as ObjectOrientation.gof in the project folder. 

When checking Write Voxel Geometry with Object Indices (*.g32) or Write 
Voxel Geometry with Object Indices (*.leS), the objects are saved into a 3D 
image file in which the object ID corresponding to each voxel is stored. Choosing 

these options generates one file in GeoDict’s format in binary format (*.g32) and one 
file in ASCII (*.leS). 

RESULTS 

Click OK to input the entered parameters (here, Use Current GAD Structure was 
used), and then click Run in the MatDict section to start the structure analysis. The 

result file (*.gdr) is opened in the Result Viewer after the computation is finished. 
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In the Results - Report subtab, the following values are reported: 

◼ Total number of GAD objects is the number of all objects present in the 3D 
structure. 

◼ Analyzed number of GAD objects is the number of objects considered in the 
analysis. This number is different from the above number if Analyze Selected 
Material ID was chosen. In this case only the number of GAD objects of the 
selected material ID is reported here. 

◼ The Number of overlap objects shows how many overlap objects are present in 
the structure. 

◼ The Number of objects in domain (GAD + Overlap) is the sum of the total 
number of GAD objects and the number of overlap objects inside the current 
domain. It is possible that some objects lie completely outside of the domain, and 

in this case, they are not counted here. 

◼ Overlap solid volume percentage is the volume fraction of the overlap objects.  

The resulting numbers depend on the way overlapping objects are treated. How 
overlap is handled is typically defined at the creation of the structure but can also be 
modified later using the Edit Domain command from the Objects’ context menu.  

See the GadGeo handbook for a more detailed description of this command. 

 

If Analyze Object Contact was checked (see page 59), the total number of contacts 
and the mean coordination number are reported in the Contact section of the report. 

Here, the Mean Coordination Number is defined as  

2 * Total Number of Contacts / Number of Objects in Domain (GAD + Overlap) 

More detailed results for all contacts are available under the Results - Map subtab: 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024&heading=EditDomain
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Under the Contacts key, for each contact the index numbers of both objects and 
the number of contact faces are given. In the above example, the first contact is 

between object number 1 and object number 125 and has a size of 27 voxel faces. 
The second contact is between object number 1 and object number 1760 and has a 
size of 35 voxel faces. 

Under the Results - Plots subtab, the Contact Area Histogram visualizes the size 
distribution of the contact areas:  
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If Analyze Object Volume was checked (see page 59), the minimal, maximal, and 

mean volume are stated in the Object Volume section. Furthermore, an Object 
volume histogram table is plotted based on the Volume Histogram settings 
defined in the post-processing panel on the left-hand side of the Report tab. 

 

The X-Axis pull-down menu allows choosing whether the components should be 

classified based on volume (Volume) or based on volume equivalent sphere diameter 
(Equivalent Diameter). 

For the Y-Axis pull-down menu, the Relative Count Probability provides the 
number of components in each bin normalized to the total number of components. 
The Cumulative Count Probability is the sum of the Relative Count Probability over 

all bins starting from the smallest bin. Relative Volume Probability gives the 
volume of the components within one bin normalized to the total volume of all 

components. The Cumulative Volume Probability sums up the Relative Volume 
Probability of each bin of the histogram starting from the smallest one. 

The histogram Mode offers the choice between generating an Automatic Histogram 

without further specifications or to Give Min. and Max Value for the parameter 
defined in the X-Axis pull-down menu (Volume or Equivalent Diameter). Either Min. 

Volume and Max. Volume or Min. Diameter and Max. Diameter can be directly 
entered here.  

 

The number of Histogram Bins determines the number of rows in the Object 

Volume Histogram table. 

The object volume histogram is graphically shown under the Result - Plots subtab. 

In the plot, the values for each bin are visualized as bars.   

The table and plot update when the Apply… button is clicked after changing the 
Volume Histogram input parameters. 
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More parameters can be defined by clicking Plot Options at the bottom of the panel 
and choose Edit Axis Settings or Edit Graph Styles for the desired plot.  
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DATA VISUALIZATION 

Depending on the input data file type and the options chosen in the input dialog, the 
Data Visualization tab allows different visualization options.  

If Use Current GAD Structure was used as Object Data input, the Data 

Visualization tab offers visualization of object overlap and object orientation.  

 

By clicking the Objects and Overlap (*.gdt)’s Load *.gdt button, the overlap 

between objects is displayed. All objects are assigned to Material ID 01 and the 
overlap is assigned to Material ID 02.  
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It is possible to visualize the contact voxels by clicking on the Objects and Contacts 

(*.gdt)’s Load *.gdt button. All contact voxels will be marked with material ID 02:  

 

For the visualization of the labeled contacts only, select Settings → Color & 

Visibility Settings in the menu bar. Uncheck the visibility of all the material IDs in 

the structure model and check only the visibility of the Material ID 02. 
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If Write Object Orientation (*.gof) was checked (see page 59), the orientation of 

the objects can be displayed by clicking the Load *.gof button for GeoDict 
Orientation file (*.gof).  

To properly see the orientation data of each object, uncheck View → Structure in 

the Visualization Settings, uncheck the Pore material in the Material selector under 
the Visible on Material IDs menu under the Volume Field tab as shown below. 

 

If Write Voxel Geometry with Object Indices (*.g32) or Write Voxel Geometry 
with Object Indices and (*.leS) was checked (see page 59), the index image of 

the identified objects is loaded by clicking on the Load *.g32 or Load *.leS button.  

In this image, every object is visualized with a different color. Again, to visualize the 

results, it is important to uncheck View → Structure in the main menu.  
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GAD OBJECTS ORIENTATION 

The GAD Objects Orientation command computes the orientation of GAD objects. 

The GAD Objects Orientation dialog opens when clicking the Options’ Edit… 

button. 

 

At the top of the dialog, enter the Result File Name. The result file is saved in the 
chosen project folder (File → Choose Project Folder in the menu bar). 

From the Orientation for Type pull-down menu, select the object type that should 
be analyzed. All object types present in the current structure are identified 
automatically and are listed in the pull-down menu. 

If no analytic data is available for the current structure, the object orientation analysis 
is not carried out after clicking Run in the MatDict section, and a warning message 

appears. 

 

Not all object types are suitable for an orientation analysis. If this is the case an error 

message appears. 

RESULTS 

Click OK to input the entered settings, and then click Run in the MatDict section to 

start the structure analysis. The result file (*.gdr) is opened in the Result Viewer 
after the computation is finished. 
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The definition of these parameters is the same as in the FiberGeo module. See the 
FiberGeo handbook for a more detailed description of these parameters.  

In FiberGeo, the parameters are used to describe the orientation of the randomly 
created fibers. That means, MatDict GAD Objects Orientation can be used to 
generate a 3D structure with FiberGeo that has a similar orientation. 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FiberGeo&release=2024&heading=Orientation
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ALGORITHMS 

EUCLIDEAN DISTANCE TRANSFORM 

For a given material in a structure, a distance transform computes the distance to the 
boundary of the material for every point (voxel) in the structure 

(https://en.wikipedia.org/wiki/Distance_transform). After selecting Euclidean 
Distance Transform (EDT) from the pull-down menu, the settings for the 
calculations can be modified through the Edit… button.  

 

In the Euclidean Distance Transform dialog, choose the Result File Name. 

Decide which Domain Boundary Conditions should be used during the calculations. 
More detailed information about this feature is given in the PoroDict handbook in the 
section of the Pore Size Distribution (Granulometry) command. 

The Distance Mode defines the material IDs that are considered. From any point 
(voxel) inside these material IDs the distance to the nearest boundary to all other 

material IDs is calculated. The default is to analyze the pore space. However, if 
switching the Distance Mode to GivenID, all material IDs present in the structure can 

be selected. 

 

If Component Distance is selected, for each point of the domain the distance to the 

next boundary is computed. In this case all boundaries between the materials are 
considered, including the pore space. When Component Distance is checked, the 

selection of Distance Mode is disabled, as the EDT is used for all structure components 
at once. 

If Signed Distance is checked, a modified version of the EDT is used. In the pore 

space or background materials, the signed EDT will be the same as in the original 
version, but the signed EDT will also compute a negative distance inside of the solid 

or foreground material. 

https://en.wikipedia.org/wiki/Distance_transform
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PoroDict&release=2024&heading=GeometricPSD
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To run the calculations with High Resolution might be useful when the pore space 

is expected to be especially narrow. The calculation run time and memory usage are 
increased. See page 29 for more explanations. 

RESULTS 

Click OK to input the entered parameters and then click Run in the MatDict section 
to start the structure analysis. The Result Viewer opens at the end of the 

computation and the result file is automatically saved in the project folder. In the 
Results – Report tab three values can be found.  

The Maximal distance value is the maximal value found in the computed Euclidean 

distance map. It corresponds to the maximal distance a point within the selected 
Material IDs can have to the next boundary.  

The Minimal distance value is the minimal value found in the computed Euclidean 
distance map. Be aware, that this is in general not the minimal distance a point within 
the selected Material IDs can have to the next boundary, because also the values 

inside of the solid materials are taken into account. In the standard case, the Minimal 
distance value will be 0. For signed distance maps, the result corresponds to the 

maximal (negative) distance a point within the solid material can have to the 
boundary.  

The Mean distance value is the average of all values in the computed Euclidean 
distance map. All materials (foreground and background) are taken into account when 
the average distance is determined.  

 

DATA VISUALIZATION 

The Euclidean Distance Transform result can be visualized in 2D-Cross section 

view or 3D-Rendering when selecting the Data Visualization tab of the result file.  

 

By clicking Load *.dst, the computed Distance Map is loaded into GeoDict. 

The Volume Field tab (in 2D Cross section view and in 3D Rendering) becomes 
selectable in the Visualization Panel above the Visualization Area to fine-tune the 
visualization settings.  
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To see only the volume field, turn off the visualization of the structure (uncheck 

Structure in the tab header). 
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SKELETONIZER 

The Skeletonizer reduces a structure to its center lines. This command might be 
useful as an intermediate step in some workflows creating or analyzing certain 

structure types. 

 

The command requires no parameters. It can directly be started by clicking Run in 
the MatDict section. 

RESULTS 

In contrast to all other commands in MatDict, the Skeletonizer command does not 
create a result file. Rather, it directly modifies the current structure and creates a new 

voxel structure which consists only of the center lines. 
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